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INTRODUCTION

Officer performance reports (OPR) and enlisted performance reports (EPR) are a vital part of an individual's record.  OPRs/EPRs provide a permanent, long-term record of a person's performance.  They are a primary source of information used to make decisions that affect a person's career.  As such, supervisors are challenged to focus their efforts on the content of performance reports to ensure a true reflection of performance. At the same time, our administrative staffs need to be challenged to produce accurate reports. Both should work in concert to produce a high-quality product that reflects an accurate word picture of an individual’s performance and potential.


This guide is a straightforward, easy-to-use source of information for anyone who writes, prepares, or reviews OPRs/EPRs. It answers commonly asked questions related to OPRs/EPRs and provides written guidance for standardizing 9 AF unique terms and phrases.  It highlights common errors made on OPRs/EPRs and offers guidance, tips, and examples to help you avoid these mistakes. It also gives instructions on how to process evaluations electronically for senior rater endorsement.


Please take the time to study and learn this guide.  It will be time well spent while making your job easier and reducing reports returned for corrections.  A report done right the first time means less work for everyone involved.  Again, each of you must give OPRs/EPRs the utmost attention and treat each one as if it were your own. If your monitor has any questions regarding our program requirements, please have them contact the 9AF Commanders Support Staff at DSN: 965-2939.














WALTER E. BUCHANAN III









Lieutenant General, USAF









Commander, Ninth Air Force

CHAPTER 1

GENERAL INFORMATION
	1.1.  References.  The following references are to assist you in preparing performance reports: 

	AFI 36-2406
	Officer and Enlisted Evaluation Systems

	AFMAN 33-326
	Preparing Official Communication

	AFH 33-337
	The Tongue and Quill

	Joint Pub 1-02
	DoD Dictionary of Military and Associated Terms

	This guide is to be used as supplemental information only.  If there is a conflict between this guide and one of the references listed above, the referenced document will take precedence.


TABLE 1.2 <REMOVED>
CHAPTER 2

EVALUATION ROSTERS FROM PC-III

2.1.  Requesting Rosters.  The “Combined Officer/Enlisted Alpha Performance Information Roster” and the “Individuals Due EPR/OPR Roster” are 2 PC-III products that can aid in effectively managing your unit’s evaluation program.  

2.1.1.  To request a Combined Officer/Enlisted Alpha Performance Information Roster, from the Reports and RIPs menu in PC-III, follow sequence below:

- Select and transmit Performance Reports

- Select and transmit Combined Performance Reports

- Then select and transmit Combined Officer/Enlisted Alpha Performance 

   Information

2.1.2.  To retrieve your roster, exit to the Main Menu and follow the sequence below:

- Select and transmit on Office Automation
- Select Products and Productions

- Mark your file with a space bar and press F10 for selections i.e. View, Print, 

   Edit, etc.  

2.1.3.  To forecast upcoming reports:  From the Reports and RIPs menu, follow the sequence below:

- Select and transmit on Reports

- Select and transmit Performance Reports

- Select and transmit Combined Performance Reports

- Select and transmit Individuals Due EPR/OPR

- From here choose desired sort and follow on-screen instructions

2.1.3.1.  To retrieve your product, exit to the Products and Productions file of Office Automation and follow the same directions listed in Paragraph 2.1.2 above.

2.1.3.2.  EPR/OPR Notices/Shells.  It's a supervisor's responsibility to know whom they rate and when their ratee's next report is due.  EPR/OPR notices/shells are needed to verify info (DAFSC, Duty Title, Unit, etc.) however; shells are not necessary to start writing the report.   If an EPR/OPR notice is not received approximately 60 days before the closeout date, call the 9 AF/CSS  (Exceptions:  Direct Reporting Units (DRUs) and off-base units under 9 AF, not serviced by the 20 MSS, will contact their servicing Commander’s Support Staff or Military Personnel Flight (MPF) for assistance in obtaining shells).
CHAPTER 3

EPR PREPARATION

3.1.  Forms Used.
3.1.1.  AF Form 910 (IMT- V1) (AB through TSgt).

3.1.2.  AF Form 911 (IMT-V2) (MSgt through CMSgt).

3.1.3.  Forms will be prepared using IMT program.

3.1.3.1.  Current forms can be downloaded from: http://www.e-publishing.af.mil.

3.1.3.2.  Initiate the process by creating an evaluations form file.  Fill out the form, using the individual’s data that will be provided from the personnel file (Individual EPR Shell). 

Figure 1.
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3.1.3.3. Once the report is filled in, save the form by clicking on the “Save” Icon on the form (See Figure 2).  Save the form as “Last Name, First Name, Rank”.  Ensure you specify the correct location to save the form to on your computer.  Once you select the name and location to store, hit SAVE.

Figure 2. 
[image: image2.png]2|

Savem [ e =] - & ot -

- |

DA i B s 2 T omE B





3.2.  Section I:  Ratee Identification Data.

3.2.1. Complete form in accordance with AFI 36-2406.

3.2.2.  All information in Part I will match EPR shell.  If the shell is incorrect, use correct information and provide source document(s) verifying change(s) have been updated in the system.

- NAME:  Ensure name is all uppercase.

- SSN:  Ensure member’s social is correct and that it matches the EPR shell.

- GRADE:  Grade should reflect period of the report (as of the c/o date).

- DAFSC:  Duty Air Force Specialty Code needs to reflect as current. 

- ORGANIZATION, COMMAND, LOCATION:  Use the full name of the organization to ensure it fits on one line.

- PAS CODE:  If an individual is administratively assigned to a different PAS code than where they are physically working, enter the assigned information, followed by “ with duty at...” to indicate where the member actually performed duties.

   (Example: 20 FW with duty at Headquarters Ninth Air Force (ACC), Shaw AFB, SC)

- SRID:  (If applicable...Senior Rater Identification should be 1C440).

- PERIOD OF REPORT:  Inclusive dates should match EPR notice. If different or incorrect please use information located in AFI 36-2406, see Table 3.1, notes 4 and 5.

- NUMBER OF DAYS SUPERVISION:  The number of days the rater supervised the ratee during the reporting period.  Remember to deduct all periods of 30 consecutive days or more days during which the ratee did not perform duties under the supervision of the rater due to TDY, including leave or “time off” in conjunction with TDY, etc.

- REASON FOR REPORT:  From EPR notice and as determined by Table 3.3 of AFI 36-2406.  (Note:  Shell is not always correct, verify if report is Annual or CRO).
3.3.  Section II:  Job Description.

3.3.1.  DUTY TITLE:  Enter the duty title reflected on the EPR shell in all uppercase, and spell out.  If duty title is incorrect on shell, use the correct duty title and submit a copy of the source document that changed the duty title or provide documentation of requested change with the evaluation package.

3.3.2.  KEY DUTIES, TASKS, AND RESPONSIBILITIES:  Enter a clear description of the ratee's duties, tasks and responsibilities, completely filling the block.  Describe the nature of the ratee's tasks, the level of responsibility, and the number of people supervised.  Include the dollar values of assets and resources managed.  Avoid using exact dollar amounts, rounded figures are encouraged.  Include previous duty during the reporting period only if it will be mentioned in the rating section or comments section of the EPR.

3.3.3.1.  Should reflect the uniqueness of each ratee's job and not be standardized.

3.3.3.2.  Be specific and include level of responsibility, number of people supervised, dollar value of resources accountable for, or projects managed, etc.

3.3.3.3.  Additional duties directly related to the member's primary duty and previous jobs held during the period of report that impact the evaluation may also be mentioned.

3.4.  Section III:  Evaluation of Performance.  Enter a computer generated "X" in the appropriate box for each area after carefully evaluating the member's performance.

3.5.  Section IV:  Promotion Recommendation.  Enter a computer generated “X” for the rater and additional rater's overall promotion recommendation.

3.6.  Section V:  Rater's Comments.
3.6.1.  Must be in bullet format.  Each bullet is not to exceed three lines to include sub-bullets.

Example:  
- Main bullet

Sub-bullets will be indented two spaces and have one space between the dash and the first    word.

Example:  
- Main bullet





   -- Sub-bullet

3.6.2.  Overall performance and performance-based potential remarks are based on performance of the ratee compared with the performance of others in the same grade and AFSC.

3.6.3.  Evaluator must consider promotion recommendation statements, if appropriate, in the final bullet.

3.6.4.  If the rater is a single evaluator, annotate Section VI (AF Form 910), Additional Rater’s Comments, or Section VI (AF Form 911), Additional Rater's Comments and Section VII, Reviewer’s Comments - This Section Not Used and initial in corresponding signature block(s).

3.6.5.  Feedback:  Document the date the last performance feedback was conducted.  The date feedback was conducted must be after the supervision effective date.  If this date is omitted, the rater must provide a reason for not conducting the feedback session.  Absence of the rater or ratee due to TDY, administrative oversight and lack of a feedback notice are not acceptable reasons for failing to conduct performance feedback.

3.6.6. Sign and date the EPR on or after closeout date.  If the EPR is reaccomplished, ensure it's dated on the date actually resigned, provided it is after closeout date.  Note: If sent back for corrections, it should be dated with the current date.

3.6.7. Stratification.  Quantify to the maximum extent possible.  Recommend no stratification outside of the top 10% of a peer group.   If stratifying a ratee among wing personnel, push notes must accompany the report.
Ten percent stratification rule is mandatory for 9AF/USCENTAF CC comments block  

Unacceptable Example: Top 10% of SNCOs 

Acceptable Example:  Top 10% of 60 SMSgts is acceptable; My #6 out of 60 MSgts is better. 

If “Top 1%” statement is used, unless there are over 300 people in the category being compared, percentages are more hurtful (credibility-wise) than helpful.  It is better to just say #1 or #2 of… 

Unacceptable Example:  "Top 1% of SNCOs I've ever worked with"

 (Because it is unusual to compare an E-7 to an E-8 or E-9). 

Acceptable Example:  "Top 1% of SMSgts I've ever worked with" 

(Better if there is a number of SMSgts worked with included).

3.7.  Section VI:  Additional Rater's Comments (AF Form 910).
3.7.1.  Must be in bullet format.  Each bullet is not to exceed three lines to include sub-bullets.

3.7.2.  If Additional Rater is 9 AF/CC, only single bullet lines are allowed.

3.7.3.  The Additional Rater must be the rater's rater provided the requirements of AFI 36-2406, Paragraph 3.1.2 are met.

3.7.4.  See AFI 36-2406, paragraph 3.6.5 and table 3.2, note 7 if there are disagreements with  ratings.

3.8.  Section VI:  Additional Rater's Comments (AF Form 911).
3.8.1.  Must be in bullet format.  Each bullet is not to exceed three lines to include sub-bullets.

3.8.2.  If Additional Rater is 9 AF/CC, only single bullet lines are allowed.

3.8.3.  Used to support the rating decisions of the rater.  See AFI 36-2406, Table 3.2, Note 7 if there are disagreements with ratings.

3.9.  Section VII:  Commander’s Review (AF Form 910).
3.9.1. The commander assigned for administrative purposes (on G-series orders) to the ratee’s organization will conduct a quality review of the EPR, mark concur or nonconcur and sign in this section.

3.9.2.  If the commander has signed as an evaluator on the report, “N/A” will be annotated in this section.

3.10.  Section VII: Reviewer’s Comments (AF Form 911).
3.10.1.  Must be in bullet format.  Each bullet is not to exceed three lines to include sub-bullets.

3.10.2.  If Additional Rater is 9 AF/CC, only single bullet lines are allowed.

3.10.3.  The reviewer must be at least a Major, but can be no higher in the organizational structure than the senior rater.

3.10.4.  The senior rater's indorsement should be reserved for individuals whose performance is clearly above that of others in the organization and who merit immediate promotion.  At a minimum, to qualify for senior rater indorsement, the ratee must be time-in-grade eligible (TIG) and have completed SNCO Academy either by correspondence or in residence. 
3.10.4.1.  CMSgt reports may be forwarded for senior rater indorsement based on performance.

3.11.  Section VIII:  Final Evaluator's Position (AF Form 911).  Neatly enter a handwritten or computer-generated “X” in the appropriate box.  Use the following examples as guidance for submitting reports to 9 AF/USCENTAF:
   
A.  Senior Rater 

9 AF/USCENTAF Commander 

B.  Senior Rater's Deputy
Director of Staff/group or squadron commander /agency chiefs who report directly to 9 AF/USCENTAF Commander

C.  Intermediate Level
Directly works for senior raters deputy (ie., unit commanders and division chiefs)

   
D.  Lower Level

 All others 

3.12.  Section IX:  Time-In-Grade Eligible (AF Form 911).  Enter a computer generated “X” in the appropriate box.  
3.13.  Additional Information.  The following 9AF/USCENTAF Preferences are provided to assist you in preparing timely and accurate EPRs.

3.13.1.  All EPRs will contain evaluations by at least two evaluators unless the rater qualifies as a single evaluator (e.g., Colonel and above or GS-15 and above).  

3.13.2.  For an explanation of prohibited comments on EPRs, refer to AFI 36-2406, Paragraph 3.7 under “Inappropriate Evaluator Considerations and Comments” section. 

3.13.3.  As a preference ellipses are used in place of semicolons.

3.14. Package Assembly for Evaluations not requiring Senior Rater Indorsement.  In an effort to expedite processing of reports and provide a quick turn-around to the field, we need to ensure the packages submitted are in a standardized format.  Report package should be mailed in a pocket folder with the tracking sheet attached to the front cover.

Left Pocket:  A report shell must accompany each report.  Any change to the report or notice requires a source document from PCIII showing the update.  

Right Pocket:  The original report only.
3.15. Package Assembly for Evaluations requiring Senior Rater Indorsement.  In an effort to expedite processing of reports and provide a quick turn-around to the field, we need to ensure the packages submitted are in a standardized format.  Report package should be mailed in a pocket folder with the tracking sheet attached to the front cover.

Left Pocket:  

· A report shell must accompany each report.  Any change to the report or notice requires a source document from PCIII showing the update.  

· Late letter – required for reports received after the 10 days suspense

· Previous 3 EPR’s (this is to determine logical progression in amount of assigned responsibility)

· Additional documentation – internal coordination/transmittal sheets returned for correction letter(s)

Right Pocket:  The original report only.
CHAPTER 4

OPR PREPARATION
4.1.  Forms Used.

4.1.1.  AF Form 707A (IMT-V1) (Major through Colonel).

4.1.2.  AF Form 707B (IMT- V2) (First Lieutenant through Captain).

4.1.3.  Forms will be prepared using IMT programs.

4.1.3.1.  Current forms can be downloaded from:  http://www.e-publishing.af.mil/.

4.1.3.2.  Colonels and above evaluation processing, contact  9 AF A-1/ DPP.

4.2.  Ratee Identification Data.  Complete this section IAW AFI 36-2406, Table 3.1.

4.2.1.  All information in Part I will match OPR shell.  If the shell is incorrect, use correct information and provide source document(s) verifying change(s) have been updated in the system.

- NAME:  Ensure name is all uppercase.   

- SSN:  Ensure member’s social is correct and that it matches the OPR shell.

- GRADE:  Grade should reflect period of the report.

- DAFSC:  Duty Air Force Specialty Code needs to reflect as current.

- PERIOD OF REPORT:  Inclusive dates should match OPR notice.  If different or incorrect please use information located in AFI 36-2406, Table 3.1. Notes 4 and 5.

- NUMBER OF DAYS SUPERVISION:  The number of days the rater supervised the ratee during the reporting period.  Remember to deduct all periods of 30 or more consecutive days. 

- REASON FOR REPORT:  From OPR notice and as determined by Table 3.3 of AFI 36-2406.

- ORGANIZATION, COMMAND, LOCATION:  Use the full name of the organization to ensure it fits on one line.

- PAS CODE:  If an individual is administratively assigned to a different PAS code than where they are physically working, enter the assigned information, followed by “ with duty at...” to indicate where the member actually performed duties.

   Example: 20 FW with duty at Headquarters Ninth Air Force (ACC), Shaw AFB, SC

4.3.  Unit Mission Description.  Enter 9AF/USCENTAF CC approved unit mission description.  Each unit must have the same mission description on every OPR. *Request each unit provide mission description for their unit.

4.4.  Job Description.  Duty title will be all uppercase.

4.4.1.  KEY DUTIES, TASKS, AND RESPONSIBILITIES:  Enter a clear description of the ratee's duties, tasks and responsibilities, completely filling the block.  Describe the nature of the ratee's tasks, the level of responsibility, and the number of people supervised.  Include the dollar values of assets and resources managed.  Avoid using exact dollar amounts, rounded figures are encouraged.  Include previous duty during the reporting period only if it will be mentioned in the rating section or comments section of the OPR.

4.4.1.2. SIGNIFICANT ADDITIONAL DUTY (IES):  Put statement in if additional duties are listed. If the statement does not fit, eliminate “SIGNIFICANT ADDITIONAL DUTY (IES).”

4.5.  Impact On Mission Accomplishment.  Use bullet format.  Each bullet is not to exceed three lines to include sub-bullets.  This section should focus on mission impact and not assessments such as “combat guru, educational expert, etc.”   Reference AFI 36-2406, paragraph 3.7, for inappropriate comments and statements.  Use action words in the past tense; remember, the report must describe what the ratee did during the reporting period and state the result/or impact on unit mission accomplishment.  Address only the items described in key duties, tasks and responsibilities.  Be specific and quantify the use of numbers and percentages. 

4.5.1.  Do not make recommendations for PME, next assignment, etc. in this section.

4.5.2.  Each item entered should document a specific responsibility or task and results–what the ratee has done and how well it was done; i.e., mission impact.  

4.6.  Performance Factors.  Enter a computer-generated "X" in the appropriate box for each factor after carefully evaluating the officer's performance and qualities.

4.6.1.  Evaluator considerations may extend beyond just on-the-job performance.

4.7.  Rater Overall Assessment.
4.7.1.  Use bullet format.  Each bullet is not to exceed three lines to include sub-bullets.  

4.7.2.  Refer to AFI 36-2406, Chapter 3, Paragraphs 3.6 and 3.7 for “Mandatory Comments” and “Inappropriate Evaluator Considerations and Comments”.

4.7.3.  Promotion recommendations whether implied or actual are prohibited.                           This includes use of the term “senior” which is commonly understood as a euphemism for Colonels and above or as a reference to someone holding a grade higher than the ratee.  This constitutes an implied promotion statement and is prohibited on OPRs.

Prohibited Examples:


               - Performs like a Lieutenant Colonel (Major ratee)


   - Already sitting in a Colonel's position (Lieutenant Colonel ratee)


   - Performing at field grade level (Captain ratee)


   - This senior logistician is head and shoulders above peers (Major ratee)

4.7.4. Command Push:  Officers can be recommended for command positions, assignments and PME as long as the recommendation is appropriate and realistically achievable for the officers current grade plus one if the officer has completed or is currently completing the last reasonable development step for the current grade.  A rated Major for instance, can be recommended for the job as the commander of a flying squadron if he has completed a tour or is currently in the position of Squadron Operations Officer.  
4.7.5.  The term “Commander in Chief” is no longer authorized when referring to any commander other than the President of the United States.

4.7.6.  Recommendations to select for a particular assignment, such as PME, continuation, or Conditional Reserve status are appropriate.  NOTE:  Assignment and PME recommendations must be consistent with ratee’s current grade.  (please refer to AFI 36-2406, Paragraph 3.7.22 and HQ USAF/DP message, DTG 172024Z Dec 01 “OES Policy Message.”)
4.7.7.  Feedback:  Document the date performance feedback was conducted.  If the date is omitted, the rater must provide a reason why the performance feedback was not conducted.  Absence of the rater/ratee, due to TDY, administrative oversight, or lack of feedback notice are not acceptable reasons for failing to conduct a performance feedback.

4.7.8.  Sign and date the OPR on or after closeout date.  If the OPR is re-accomplished, ensure it's dated on the date actually resigned, provided it is after closeout date.  Refer to AFI 36-2406, Table 3.1, Note 12 for exceptions.  

4.8.  Additional Rater Overall Assessment.
4.8.1.  Use same guidelines as Section VI, with the exception of Paragraph 3.7.6.  Do not sign or date the report earlier than the date previous evaluator signed report.

4.8.2.  If the rater is also the reviewer leave this section blank and type: 

“RATER (or ADDITIONAL RATER, as appropriate) IS ALSO THE REVIEWER”. 

4.8.3.  SIGNATURE BLOCKS:  Standardize spelling-out or abbreviating all signature block ranks throughout the report.  Ensure signatures are dated after the report closeout date.  Use current dates each time a package is returned for correction/reprint.                                             Do not date 9 AF/USCENTAF CC’s signature block.  Remember to include the correct last four of the evaluator’s SSN.  

4.8.4.  Stratification.  Quantify to the maximum extent possible.  Recommend no stratification outside of the top 10% of a peer group.

Ten percent stratification rule is mandatory for 9 AF/USCENTAF CC signature block 

Unacceptable Example:  Top 10% of CGOs 

Acceptable Example: Top 10% of 60 CGOs is acceptable; My #6 out of 60 CGOs is better.  

If “Top 1%” statement is used, unless there are over 300 people in the category being compared, percentages are more hurtful (credibility-wise) than helpful. It is better to say #1 or #2 of …

Unacceptable Example:  "Top 1% of officers I've ever worked with" 

   (Because it is unusual to compare an O-4 to an O-1) 

Acceptable Example:    "Top 1% of majors I've ever worked with"

4.8.5  IDE/SDE recommendations MUST be IAW 36-2406, para. 3.7.22.2. PME STATEMENTS:  Recent promotion briefings indicate that unless there is a consistent push for PME, the hidden message is “do not promote”.  Use the following guide for PME pushes:

2Lt-1Lt:  Basic Developmental Education (BDE) (used to be Squadron Officer School [SOS]); avoid the term “BDE now,” instead use                                                                                                                       terms like “BDE soonest,” “BDE first opportunity” or “BDE when eligible”

Capt:  BDE until completed, then push for Intermediate Developmental Education (IDE)

Maj:  IDE or equivalent until completed in residence; then Senior Developmental Education (SDE)

Lt Col (Sel)-Lt Col:  SDE or equivalent.  Lt Col selects must have IDE completed.

Col:  Special schools PME. 

 Comments regarding the completion of or enrollment in PME or advanced degree programs are prohibited.  Strong PME pushes should include actual names of schools or recommendations for joint PME. (Go to http://afas.afpc.randolph.af.mil/pme/schools-info.htm for more information on all IDE and SDE options).  Avoid the term “in residence,” it is assumed in recommendations for PME. Special schools (AFIT, AFIP, ICAF) should also be recommended for members whose performance and preference warrant consideration.
4.9.  Reviewer.

4.9.1.  For Majors and below, the reviewer must be at least a Colonel or equivalent serving in a wing commander or equivalent position as determined by the management level.

4.9.2.  For Lieutenant Colonels and Colonels, the reviewer is the first General officer or equivalent in the rating chain.

4.9.3.  Reviewers may comment only under limited circumstances.  Refer to AFI 36-2406, Table 3.1, Note 11, for details.  If the additional rater is also the reviewer, type ADDITIONAL RATER IS ALSO THE REVIEWER (center block – align left) in Block VIII in accordance with AFI 36-2406, Paragraph 3.6 “Mandatory Comments.”
4.9.4. 9 AF/USCENTAF Commander COMMENTS BLOCK:  Use single-line bullets only. Avoid the use of first names in the block and terms like “my wing’s #1 …”; “my top priority …”; “when my wing needs …” or “I count on (name) to produce …”

- Reference 9 AF/USCENTAF Commander (USCENTAF/CC) instead of the commander personally.

- Make specific recommendations for future jobs commensurate with current or next rank (i.e., do not recommend a rated Captain for squadron commander).  Do not make veiled promotion statements.

CHAPTER 5
ELECTRONIC PROCESSING 

5.1.  SYNOPSIS.  Electronic processing must be accomplished for all reports seeking Senior Rater Endorsement.  The package must include the following:

- Completed Draft IMT


- Word Template 


- Electronic Tracking Sheet 


- Electronic Assignment Management System (AMS) Surf 

- Scanned EPR or OPR notice

- EPRs only:  Scanned copies of last 3 EPRs (for Command CMSgt review)

5.2.  DRAFTING ELECTRONIC OPR/EPR.  Prepare a draft of the OPR/EPR using the appropriate IMT form.  Route report through your unit coordination using your squadron's or division's current procedures.  When the OPR/EPR is in final draft, use the appropriate MS Word “EVALUATION REPORT DRAFT COMMENTS TEMPLATE” see Figure 3 & 4 for external coordination through 9 AF/USCENTAF per the procedures within this guide.  Each squadron or division will have to decide who determines when the OPR/EPR is ready for external coordination.  

5.3.  PRIVACY ACT (PA).  It is imperative you remember that e-mail messages and Word files will contain privileged information as defined in AFI 33-332, Air Force Privacy Act Program. This information should only go to those who have a legitimate interest in the process and must be afforded adequate protection from unauthorized disclosure.  To ensure the information is properly safeguarded, use a PA statement at the beginning of each E-mail package and only use the Evaluation Template. 

5.4.  WORD TEMPLATE PROCEDURES.  (See Attachment 1 or 2 that was disseminated with this guideline.  ) The word template will be used to allow reviewers in the process to make suggested edits which can be tracked and viewed.

INSTRUCTIONS:

- Open the appropriate “EPR/OPR WORD TEMPLATE” (Figures 3 & 4 show examples on the next page.) 
             Figure 3. (EPR TEMPLATE)
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WITACHMENT I EPR WORD TEMPLATE

N ‘THIS DOCUMENT CONTAINS PRIVILEGED INFORMATION AS DEFINED IN AFI 33332, PRIVACY ACT PROGRAM OF 1974 AND IS TO BE USED FOR
ISOLATED REPORTING PURPOSES ONLY.
‘THIS DOCUMENT MUST BE AFFORDED ADEQUATE PROTECTION FROM UNAUTHORIZED DISCLOSURE. ANY INDIVIDUAL RECEIVING THIS
DOCUMENT IN ERROR, DELETE FROM YOUR E-MAIL INBOX AS WELL AS YOUR DELETED FILES FOLDER.

: FROM: CLICK HERE AND TYPEPOC: RANK, NAMEPHONE]" | UNITOFPOC: *[CLICK HERE ANDTYPEUNIT & GOOD CONTACT NUMBER]"
SUBJECT:  CLICKHERE ANDTYPE SUBJECTEPROPR'

: RATEE'S NAME: "[CLICK HERE AND TYPENAVE RANKLAST, FRISTM]' | PASCODE:  [CLIGC HERE ANDTYPEPAS CODE]"
'DATE OPENED:  TUESDAY, MARCHS0, 204 CLOSEOUT DATE: Y{CLICK HERE AND TYPE DATE FROM SHELLT"

ILJOB DESCRFTION

- HOW TO USE THIS MEMO TEMPLATE

You may want to print these directions out before you start!
Fill in all the top CLICK HERE AND TYPE sections.

- Nest click on Fie the menu -- select Save As (ame the file & store in a folder that you will remember where to
setrieve it from later) Keep default file name *_on” only add Rank Last Name

B Now open your completed IMT Draft Evaluation Form.
- Hit the “Tab” Key until you are in block IL 2. KEY DUTIES, TASKS, AND RESPONSIBILITIES.

- Hold the Ctrl Key and press “A” to Select all the text in your KEY DUTIES, TASKS, AND RESPONSIBILITIES. *
- Next hold Ctrl Key and press “C” to Copy all the text in your KEY DUTIES, TASKS, AND RESPONSIBILITIES. 2
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            Figure 4. (OPR TEMPLATE)
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ATTACHMENT II OPR WORD TEMPLATE
N ‘THIS DOCUMENT CONTAINS PRIVILEGED INFORMATION AS DEFINED IN AFI 33332, PRIVACY ACT PROGRAM OF 1974 AND IS TO BE USED FOR
ISOLATED REPORTING PURPOSES ONLY.
‘THIS DOCUMENT MUST BE AFFORDED ADEQUATE PROTECTION FROM UNAUTHORIZED DISCLOSURE. ANY INDIVIDUAL RECEIVING THIS
DOCUMENT IN ERROR, DELETE FROM YOUR E-MAIL INBOX AS WELL AS YOUR DELETED FILES FOLDER.

: FROM: CLICK HERE AND TYPEPOC: RANK, NAMEPHONE]" | UNITOFPOC: *[CLICK HERE ANDTYPEUNIT & GOOD CONTACT NUMBER]"
SUBJECT:  CLICKHERE ANDTYPE SUBJECTEPROPR'

: RATEE'S NAME: "[CLICK HERE AND TYPENAVE RANKLAST, FRISTM]' | PASCODE:  [CLIGC HERE ANDTYPEPAS CODE]"
'DATE OPENED:  TUESDAY, MARCHS0, 204 CLOSEOUT DATE: Y{CLICK HERE AND TYPE DATE FROM SHELLT"

IIL 1OB DESCRIPTION

- HOW TO USE THIS MEMO TEMPLATE

You may want to print these directions out before you start!

Fill in all of the top CLICK HERE AND TYPE sections

- et lick on Fie the menn - sclect Save As (Name the file & store in a folder that you will remember where to
setrieve it from later) Keep default file name _on” only add Rank Last Name

P Now open your completed IMT Draft Evaluation Form.
- Hit the “Tab” Key until you are in block IIL 2 KEY DUTIES, TASKS, AND RESPONSIBILITIES

- Hold the Ctrl Key and press “A” to Select all the text in your KEY DUTIES, TASKS, AND RESPONSIBILITIES.
- Nexthold CorlKey and press “C7 1o Cogy ll the text in your KEY DUTIES, TASKS, 4D RESPONSIBILITIES

“wonls
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  Procedures: (Attachment 1 or 2) 

      - Double click on the appropriate template and it will open MS Word.

      - Print off the Attachments for directions on how to complete Word Template.

 STOP and complete printed directions for transferring IMT document to Word Template.

-Now you need to add the TRACK CHANGE OPTION.

-  (Figure 5) Track Changes:  This set-up is only required once.

-From the Tools menu, Click on Options.

- Click the Track Changes tab.

- Under Track Changes Option:


- Insertions choose Italic



- Formatting choose Double Underline





- Color choose Blue






- Ensure that the “Balloons” option is NOT checked







- Click OK                                                                              Figure 5. (Track Changes Settings)

[image: image5.png]Document |

rosoft Word =

Fle Edt Vew Inert Fomat Tods Tabe Mindow e Type > question for e
DEHa8/8RY iBRS < -« a0
FialShowing Markup  ~ how~ | & 3% 2 + & - |

[ -y i B 2 B B B 4 B s B . B 7 B s B B o

To facilitate the review tracking process, format this Word document to track all suggested edits by following the
sequence below
- From the Tools menu, choose Click on Options
Click the Track Changes tab ensure seting are as listed below.
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-  Now you need Turn On the track changes option (Figure 6) for specific Word Document.  (Ensure that this is done per document and saved).

Figure 6. (Track Changes Option)
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-  Now you’re ready to set up your 9AF E-Tracker Procedures.

5.5.   ENABLING EXCEL MACROS TO RUN:  It is required that you ensure that your Excel Macros Security is set on Medium.  (Figure 7) 
  INSTRUCTIONS:  

-  Go to in MS Excel, from Tools menu:

- Click on Options 



- Click on Security




- Click on Macro Security





- Click Medium





- Click OK

- This will allow the check box to be active.

Figure 7. (Macro Security Setting)
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- The next step is to double click on 9AF E-Tracker Sheet that was disseminated with this guideline.

- Once opened, click on ENABLE MACROS.

    Figure 8. (Enabling Macros) 
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- The E-Tracker will now open. (Figure 9)

-  Fill in all highlighted areas. 

Figure 9. (9AF E-TRACKER)
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- Next click on File the menu. 

- Select Save As (Name the file and store in a folder that you will remember where to retrieve it from later).

5.6. AMS SURF ELECTRINIC CONVERSION:  Log on to the AMS page.  Open members information, click on the Single Page Surf button.  When SURF opens, under File: click Save As, and name the file as last name of the member and save in the specified drive. 

5.7.  ELECTRONIC PACKAGE PROCESSING: Now that you created all necessary attachments, you will need to package the attachments and forward by using MS Outlook E-mail Evaluation Package. (see Figure 10 )  Email to the following address: <REMOVED>
In the Subject line, type: EPR/OPR RANK/LAST NAME/UNIT
The first part the body of the email must include the following PA statement: 
“THIS DOCUMENT CONTAINS PRIVILEGED INFORMATION AS DEFINED IN AFI 33-332, PRIVACY ACT PROGRAM OF 1974 AND IS TO BE USED FOR ISOLATED REPORTING PURPOSES ONLY. THIS DOCUMENT MUST BE AFFORDED ADEQUATE PROTECTION FROM UNAUTHORIZED DISCLOSURE.
ANY INDIVIDUAL RECEIVING THIS DOCUMENT IN ERROR, MUST DELETE IT FROM YOUR E-MAIL INBOX AS WELL AS YOUR DELETED FILES FOLDER.”

-  Now you are ready to insert the IMT, Word template, Excel tracker, and both required scanned source documents to this e-mail.  (SEND ONLY ONE REPORT PER E-MAIL) Follow the sequence below:



- Click Insert


- Select File and browse to where each file associated to this package is stored  (i.e. IMT, Word template, E-tracker, any/and all required scanned source documents).


- Click Insert.  (Document will now be embedded in your e-mail.)

Figure 10. (Example Email) 
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-Before sending the e-mail with the attachments, format your e-mail to notify you when the first person in the review process has accessed the document.

- Click File, Properties, and select Read Receipt Requested under the “general” folder.  If you do not receive a return receipt within 2 duty days, you should follow-up with a telephone call to 9 AF/CSS.
- Click Send.  Now you’re done sending the electronic package.

CHAPTER 6

FINALIZING THE OPR/EPR

6.1.  FINALIZING THE OPR/EPR.  After a draft OPR/EPR has been through the necessary reviews, it will be returned to the originating office or individual with instructions to “GO FINAL” by 9 AF/USCENTAF Commander.  Follow the sequence below to finalize to report:


- Open E-mail.  Select the electronic tracking sheet

- From the File menu, choose Print, click OK.  This will provide a written record of who coordinated on the OPR/EPR 


- Double-click on the Word icon to open the file

- From the File menu, choose Print, and click OK.  This will provide a hard copy of original file with revision marks.  This copy is used to manually update original IMT file

- Take the printed Word document and a copy of the original IMT document to the rater for review of suggested changes.  The rater can accept or decline the changes.  If changes are declined, the rater must annotate on the printed Word document why (the Word document will be included in the final package)

- When you receive the documents back from the rater, go to the IMT form and open the original IMT data file and incorporate the changes.  Double-check to ensure all approved changes were made


- Save the changes


- Print the OPR/EPR from IMT. ** Ensure the document is printed head-to-foot

6.2.  FORWARDING OPR/EPR FOR SIGNATURES.  When the OPR/EPR is sent forward for signatures, be sure to include the following:

- Tracking sheet (attached to front outside of folder); which includes suspense from CSS

                Ensure reports show coordination by HQ 9 AF group commander’s, A-heads, staff 

                agency chiefs or wing commanders  


-  E-mail message with detailed list of reviewers


-  OPR/EPR Word document with changes


-  Performance Report Notice (shell)


-  If prepared early, make sure signature date is on the date report closes out or after,  

          otherwise reports must be dated the date the report is actually signed.  


   -  Do not date 9 AF/USCENTAF CC’s block

6.2.2. White-out or correction tape on any report submitted for 9 AF/USCENTAF CC signature is prohibited.

The rater should review the package to ensure printed OPR/EPR is correct, sign and forward to the unit OPR/EPR monitor for final processing.  The unit monitor delivers package to 9 AF/CSS, Bldg 1130, Suite 111.  For DRUs and units not located on Shaw AFB, mail or FEDEX final signed reports with all supporting documentation to:



<REMOVED>
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